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Introduction

The iokeys compact data recorders measure and record data, sensed with built-in
Sensors. (For more details please visit the website: www.iokeys.com ).

All iokeys instruments use the iokeys.exe program for communication with a
computer running the Windows operating system. The computer (PC) must be
equipped with one serial RS232 communications port (Com port).

Operating the iokeys.exe program

iokeys.exe is a program that communicates with the iokeys instruments. The
program enables the setting of operational parameters of the instruments.

The settings are: measurement interval, start of recordings, current date and time.
The program also handles data retrieval, data processing and graphical display of the
data stored in the iokeys instruments.

Installing the software

Please extract the “iokeys_exe.zip” file. The software is installed by running the
setup.exe in the “iokeys_exe” files folder. The operating system required for the
program is Windows from Microsoft Corporation.

Running the iokeys.exe

A windows form is displayed on the computer screen, when the iokeys.exe starts. A
menu is displayed in the top of the form (see fig. 1)

lokeys Scientific Instruments |Z”E|g|

File Recorder Wiew

The File menu Fig. 1
Start by creating directories for data and calibration files as displayed in fig. 2 and 3.

All datafiles are stored in the datafile directory when the data is downloaded from the
instruments.
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Creating the Datafile Directory

Click on the “Datafile Directory” with the mouse pointer.
The “Save Datafile Path” is displayed. Select or create a new directory.
(Example: C:liokeys\STL_Data)
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Fig. 2
The “Save Datafile Path” is displayed. Click “Save” when finished.
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Creating the Calibrationfile Directory

Click on the “Calibrationfile Directory” with the mouse pointer.

The “Save Calibrationfile Path” is displayed. Select or create a new directory.
(Example: C:liokeys\STL_Cal)

lokeys Scientific Instruments

File Recorder ‘Wiew
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Datafile Direckory
Calibrationfile Directary

Exit
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Fig. 3

The “Save Calibrationfile Path” is displayed. Click “Save” when finished.
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Opening Datafiles

Now you can open a datafile by clicking on the open menu as in fig. 4. A dialog
window appears. If available, select a datafile and click on “Open” or simply double
click the filename. Only one datafile can be displayed at a time. For multiple datafile
displays, other programs must be used i.e. Microsoft Excel or equivalent. This can be
realized by using the print files that are available from iokeys.exe.

Datafiles are given names with dates and version. The three last digits are the
instrument serial no. (three last digits of serial no.). Datafile “yymmddvv.ser”

yy is for the year, mm for the month and dd is the day of the month. vv is the version
of the last downloaded file from an instrument. This ensures that multiple datafile
downloads will not be overwritten.

File naming example: a datafile from the instrument 0A0232 on November 1°' 2008
will have the file 08110100.232 The next file from the instrument on that same date
will automatically get the filename 08110101.232 and so on for the same data

directory.

lokeys Scientific Instruments

File Recorder

Datafile Direckory

Ezxit

Calibrationfile Directaory

Vigw

-
Recent

T

=

Desktop

'}

My Documents

%

Lookin: | £ STL_Data

(= paoa0s00. 192
(=) os00901.192
|li=f pana0a0z, 192
|l ns0a1 100170
{[=) s0s1100.c53
| oso81100,c58
|=) na0s1 100.F28
(le=f a0zt 100.F29
(le=f a0z L00.Fre
|0 ns081100.Fe2
(= oao81 109,170
|l ns0a1300.170
|[=) 0zs1400,170
(= aoa1401.170
|[= naos1500,170

= vs081501. 170
=0 os0&1502, 170
=] osns1503.170
=l oen91100.193
= ne091200, 194
= os091201, 194
= 0e091300. 195
= 0s091300. 198
= ne091300, 197
= ne091300, 198
=0 08091400, 199
= nsno1401. 199
= ne091402, 199
= vs091500, 194
= va091500, 195

|

= 05102000138
= 0z102000.172
= 08102200172
08102400230
= 05102401, 230
= 05102402, 230
05102403.230
08102404.230
= 02102500, 231
05102500,232
05102500,233
= 0a102501.231
05102600,230
08102700,230
= 0z102700, 231

? > @

O0A102700,232
08102700.233
= 05102701 231
05102300.230
[t nE 102900, 231
08102900.232
05102900,233
= 051027901 231
[ nE 1031 00,231
=) ne1 101 00,232
= 0e110100.233
03110101.232
@ iokemp0. Ext

F:j iokempl.Ext

[Z] PDatafile txt

[

My Computer | |
< |

‘,‘1 File name: 08110101.232 v
by Network, Files of type: ,3_" Files [*.%] v

Copyright (2002 —2011) iokeys lic
iokeys is a registered trademark.

All rights reserved.

Internet website: www.iokeys.com

Fig. 4



lokeys.exe User’s Guide
Version 1.02a

Displaying the data from a datafile

The data in a datafile can be displayed by opening the datafile. The calibration file for
the instrument needs to be in the “Calibration file” directory, so the calculation of the
measured values can be performed. The instruments only store “raw” values that are
in the range of 0000hex to 1000hex. The calibration files provide information of how
to calculate the actual data in a given unit (kg, °C or %RH) for the instrument.

Note: raw data values can be displayed in the table of the iokeys program by setting
the B constant equal to 1.0 in the calibration file.

Example: Calibration file for STL-SA nr.:0A0231 A=0.0 B=1.0 C=0
Please make a copy of the original calibration file before making any changes!

The graph in fig. 5 is displayed when a datafile is opened.

lokeys Scientific Instruments

File Recorder Wiew

Load Tension

Recorder setial no. #0A0231
kg — high_kg — low_kg — mean_kg
11000

10000 4
5000
8000
7000 4
E000 5
5000 4
4000 4
3000+

2000~

= 7%

il T T T T
011532 0111535 0111538 011541 01111 15:44 014111547
Hovember 01. 2008

Data from fils - C:hiokeys STL\Statnett 2008\iokeys STLASTL datah08110107.231

Fig. 5
This program is default for 10000kg max output.

Zooming in on the graph area

You can zoom in on the graph with the mouse pointer (left button).

Press the left mouse button on any spot of the graph area and hold the button down,
then drag the mouse over to the opposite corner of what you want to zoom in on.
Then release the left button.

Clicking on the right mouse button restores the graph to the original display.
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Fig. 6 shows the zooming action (2 examples).

lokeys Scientific Instruments

File Recorder Wiew

Load Tension
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Data from file Chiokeys STLAStainett 2008\iokeys STIASTL dala\08110101 231

lokeys Scientific Instruments.

File Recorder ‘View

Load Tension
Fecorder serial no. #0A40231

kg = high_kg — low_kg — mean_kg
E00
500 4
400 T T T T T
15:36:00 15:36:30 153700 153730 153800 15:38:30 15:33:00
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[ ata from file : C:hiokeys STLAStatnett 2008%ickews STLASTL data\08110101.231

Fig. 6
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The View menu
Displaying information from the datafile.
Display Options

A plotmark can be used for identifying the measurement points of the graph. Also the
user can change the back color and grid color of the displayed graph.

The user can enter the title of the graph in the title menu.

lokeys Scientific Instruments

File Recorder | Yiew
Data Table |
Back Colr
Recorder serial  Grid Color
kg — high_kg Minor Grid Color mear_kg
1000 e Tl
 Plotmark
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500
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Diata from file - Chiokeys STLNStatnett 2008%akeys STLASTL datat0E110101 231

Fig. 7

The graph displays typical calibration measurements of a tension recorder, showing
high, mean and low values for 10 minute intervals.
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Displaying the Data Table

A data table can be displayed by clicking the “View” menu and “Data Table”.
Repating the process hides the data table.

lokeys Scientific Instruments

File Recorder | View

Recarder serial no. #0A0231
kg — high_kg — low_kg — mean_kg
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300 -
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00
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Data from file : C:hiokevs STLASEatnett 2008\ickevs STLNSTL data08110101.231
s = ==

1] T T T T
01A11532 01/1115:35 mA115:38 011541 01411 15:44

01411 15:47

iokeps SA-100 instument_data

Datafile: C:viokeys_STL\Statnett_2008%iokeys_STLAVSTL_data

NOE10101. 231

No

000001
000002
000003
UINES
000005
000006
000007
00000s
000003
0000 0
000011
o000 2
000013
000014
000015
00001 &
0000 7
o000 e
0000m 3
000020
0001
000022
000023
000024
000025
000026
000z
000028
000023
000030
000031
000032
00003z
000034
000035
000036
000037
000038

h_kg

00333
00333
00333
00332
00331
00331
00391
00331
00330
00330
00333
00383
00383
00333
00876
00734
00770
00770
00770
00770
00770
00770
00770
00770
00770
00770
D0Bes
00614
00587
00582
00582
00582
00582
00583
00583
00583
00583
00583

Lkg

00333
003gz
0033
003
00330
00330
00330
003z
003z
003aa
003aa
003gs
003es
o0g33
00793
00768
00768
00768
00763
00763
0076e
00763
00763
00763
00763
00686
00g1a
00533
00560
00561
00581
00581
o0&t
00562
00561
0561
00581
00543

m_kg

00993
0099z
o099z
00351
00351
00990
00990
00990
o0geg
00323
00323
00989
00989
00958
00833
00778
00763
00769
00769
007Eg
007ES
007ES
007ES
00769
007E9
00746
O0e4z2
00607
00582
oosaz
oossz
oossz
o058z
00582
0osaz2
oosaz
oossz
00574

00450 00483
00421 - 00426
00408 00411
o040 0D40
00402 - 00402
o402 - 00403
0402 - 00403

Time

15:32:00
163210
16:32:20
16:32:30
16:32:40
15:32:50
15:32:00
163310
16:33:20
16:33:30
16:33:40
15:32:50
15:34:00
16:34:10
16:34:20
16:34:30
16:34:40
15:34:50
15:35:00
16:35:10
16:36:20
16:35:30
16:35:40
15:35:50
15:36:00
16:36:10
16:36:20
16:36:30
16:36:40
15:36:50
16:37:.00
16:37:10
16:37:20
16:37:30
15:37:40
15:37:50
16:38:00
16:38:10
16:38:20
16:38:30
15:38:40
15:38:50
16:35:00
16:35:10
16:35:20

Date

01/11/08
01/11/08
01/11/08
0111408
01/11/08
01/11/08
01/11/08
01/11/08
01/11/08
01/11/08
01/11/08
01/11/08
01/11/08
01/11/08
01/11/08
01/11/08
01/11/08
01/11/08
01/11/08
01/11/08
01411708
01/11/08
01/11/08
01/11/08
01/11/08
01/11/08
0111408
01/11/08
01/11/08
01/11/08
01/11/08
01/11/08
0111408
01/11/08
01/11/08
01/11/08
01/11/08
01/11/08
0111408
01/11/08
01/11/08
01/11/08
01/11/08
01/11/08
01/11/08

The data table is stored in a file
PdataFile.txt Or as some other
name given in the File menu
“Save as Printfile”

The information from this file
can be imported Into Microsoft
Excel or similar programs for
further processing.

Fig. 8
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est].txt - Notepad
File Edit

Format  View Help

iokeys_SA-100_instrument_data

Datafile: Cihiokeys STU\Statnett

Mo

000001
000002
000003
000004
000005
000006
000007
00000a
000003
ooao1o
00oo11
000012
000013
000014
00ao14
000016
oooo17
oooo1a
oooo19
oooo20
0ooo21
000022
000023
000024
000025
000026
000027
000025
0000249
000030
000031
000032
000033
000034
000035
000036
000037

h_ky

00965
0096s
0096s
00965
00367
00967
00965
00967
00865
00s12
007as
007as
007as
007as
007as
007as
o07as
o07as
o07as
007as
0029
00&33
00593
00aa3
00a24
00a24
00&93
00524
00593
00524
00524
00593
00s04
00419
00405
00405
00405

I_kg

00965
00967
00967
00967
00367
00967
00966
00574
00s12
007as
007as
n07as
007as
007as
007as
007as
no7as
007as
007as
00712
00&35
00592
n0s92
00a93
00a92
00493
00&93
00&92
00593
00593
00593
a0s1s
00422
00404
00404
00404
00408

m_kg

00268
00266
00266
00267
00967
00967
00967
00934
00832
00794
00732
00732
0o7aa
0o07a2
00782
0o7sa
0o7sa
0o7sa
0o7aa
00765
00B6S
00503
00592
00593
00593
00593
005593
00593
00593
00593
00593
00563
00480
00412
00404
00405
00405

Time Date

15:00:00 01/11/08
16:00:10 01411/08
16:00:20 01/11/08
16:00:30 01/11/08
15:00:40 01/11/08
15:00:50 0141108
15:01:00 0141108
15:01:10 01/11/08
15:01:20 0141108
15:01:30 0141108
15:01:40 0141108
15:01:50 01/11/08
16:02:00 01411/08
16:02:10 01411/08
16:02:20 01/11/08
16:02:30 01411/08
15:02:40 01/11/08
15:02:50 0141108
15:03:00 01/11/08
15:03:10 0141108
15:03:20 0141108
15:03:30 0141108
15:03:40 01/11/08
16:03:50 01/11/08
16:04:00 01/11/08
16:04:10 01/11/08
16:04:20 01/11/08
15:04:30 01/11/08
15:04:40 01/11/08
15:04:50 0141108
15:05:00 01A411/08
15:05:10 0141108
15:05:20 01A11/08
15:05:30 01/11/08
16:06:40 01/11/08
16:06:50 01/11/08
16:06:00 01/11/08

_2008%okeys STLASTL data\08110101 232
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The Recorder menu

The recorder menu of the iokeys program enables the user to communicate with an
instrument. The computer running the program must have a RS-232 communication
port installed. The program enables communication with 4 ports: com1, com2, com3
and com4. See fig. 9

lokeys Scientific Instruments

File | Recorder “iew

Communicate |

Cormmunications Pork  #
Comz
Comd
_omd

Fig. 9

Connect the instrument to the communications port when the port has been selected
and click on “Communicate” with the mouse pointer.

lokeys Scientific Instruments

File | Recorder Wiew

Cammurnicake

Communicakions Pork  #

Fig. 10

The following window is displayed, enabling the user to initiate the communication
with the instrument.

iokeys instrument interface

=erial number j Show Settings
Instrument type
Recordings

Sampling Interval
First recarding

Last recording
Retrieval time

Current date and time

Cloze

Fig. 11
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Show Settings

Clicking on the “Show Settings” button starts the communication, and if connected,
the instrument sends the response.

An example is given below in fig. 12:

In this example, the serial number is 0A0142 and the instrument type is THR-020,
(which is a temperature and humidity recorder).

The sampling interval is 10 minutes and the first recording was on Aug 22" 2007 at
13:10. The recorder gathered data for more than a year, as is seen from the “Last
recording”. (Data downloaded at that time, and stopped the recordings).

The “Current date and time” in the display is from the recorder, but not from the
communicating computer.

iokeys instrument interface

=erial number 0A0142
Instrument type J0KEYS THR-0Z0
Recordi ;

ecordings 061200
Sampling Interval i a0:10:00
First recording 12007 Aug 22 13:10:00
Last recording JZ008 Oct 20 13:00:00
Retrieval time (2008 Moy 07 0953220
Current date and time ;2008 Moy 07 10:25:29

Fig. 12
Read Data

By clicking on the “Read Data” button, data retrieval is initiated. Before the data
transfer to the computer, you would need to confirm or make changes to the location
of the new datafile as shown in fig. 13. Then click on the “Save” button.

Savein: | ) 5TL_data v| y ¥ = [

= = o=110100,230
__J = os110100,231
Recent = 0z110100.232
= o=110100,233
— = o=110101.230
@ = os1101m1 231
=i os110101.232
= os110101.233
5 = o=110102,233
—j = o=110103.233
= o=110104,233

|'.3=j iotempl bxt

Degktop

My Dacuments

Q [Z] test1.bxt
b Computer .
File name: 08110700138 v [ sae |
‘g Save as type: | "138 w I [ Cancel l
bl M etk

Fig. 13
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Data download is now starting as is indicated in the picture below.

iokeys instrument interface

=erial number
Instrument type
Recordings

Sampling Interval
First recarding
Last recording
Retrieval time

| Current date and time

1 e |

: 0AD135

(OKEYS THR-020

053320

D2007 Zep 10
(2008 Oct 19
2008 Mo OF
(2008 Mov OF

an:10:00
16&:10:00
16:00:00
09.54:23

10:31:18 |

Show Settingz

Read Data

Mew Settings

Cloze

The picture shows the “Reading Data” in progress.

The downloaded file can then be opened as described above.

New Settings

Fig. 14

Initiating a new measurement session is enabled by clicking on the “New Settings”
button. The sampling interval can be chosen to any value between 5 seconds and 18
hours. The first recording time needs to be atleast 2 minutes in the future. If not, then
it will be indicated in red letters. The instruments can store up to one million
measurements (see: www.iokeys.com for details for each instrument’s specifications).

First click on the “Sampling Interval” at the left in the window, which becomes an
active area “button”, after you click on the “New Settings” button. This is shown in the
picture below. Then choose the sampling time with the arrows at the bottom of the

form window.

iokeys instrument interface

=erial number
Instrument type
Recordings

| Sampling Interval |
First recording
Last recording
Retrieval time
Current date and time

c0AD142

JOKEYS THR-0Z0

081200

D 2007 Aug 22
C2008 Oct 20
C2008 Moy OF
C2008 Moy OF

ac:10:00
13:10:00
13:00:00
0% 5457
10:27:04

SO

Mew Settings
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The arrows below the display enables the setting of the parameters. Use the mouse
pointer to increment or decrement the values as you wish.

The “First recording” active area “button” enables you to change the date and time of

the first recording.

iokeys instrument interface

Serial number S 0A0142
Instrument type (ADKEYS THR-020
Recordings (0R12200
sampling Interval 00 10:00
| First recarding | 2008 Mov 15 00:00:00
Last recarding SZ008 COct 200 1300:00
Retrieval time 22008 Moy 0F 095457
Current date and time ;2008 Mow OF 102704
R N
S © O oSS

Mew Settings

Fig. 16

When the sampling interval and the first recording date and times are set, with the
small “up” and “down” arrows below the display, then click on the “New Settings”

button. The new settings are now transferred to the instrument which needs to be
connected to the computer at that time.

The current date and time of the communicating computer is automatically

transferred to the recorder when the new settings are loaded into the recorder.

NOTE!

Please check that the date and time of the communicating computer is correct, when
the new settings are loaded into the recorder.

For additional information,
please contact by email:

info@iokeys.com

Internet website: www.iokeys.com
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